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1 Introduccidén

El presente documento describe cuales son las tareas basicas que se pueden ejecutar en la explotacion
de la herramienta de modelado Enterprise Architect Corporate Edition.

El contenido del documento integra, tanto los aspectos de uso en el entorno de EJIE como las
caracteristicas elementales de funcionamiento de la aplicacion.

2 Conceptos basicos

Enterprise Architect Corporate Edition es una herramienta CASE para el disefio y construccion de
sistemas software. Desarrollada por Sparx Systems, la primera release (v1.1.3) data de Agosto del 2000,
mientras que la ultima version (v6.1) vio la luz en Mayo del 2006

Enterprise Architect Corporate Edition soporta la especificacion UML 2.0, que describe un lenguaje visual
gue permite la definicion de los modelos de un proyecto.

Se trata de una herramienta progresiva que cubre todos los aspectos del ciclo de un desarrollo,
proporcionando una completa trazabilidad desde la fase inicial de disefio hasta el desarrollo y posterior
mantenimiento. Asi mismo, también proporciona soporte para testing y control de cambios.

Enterprise Architect Corporate Edition, permite la realizacion de ingeniera directa e inversa, sincronizar
los elementos de los modelos con el cédigo fuente de las clases (ActionScript, C++, C#, Delphi, Java, Python,
PHP, VB.NET y Visual Basic), disefiar y generar elementos de base de datos y generar documentacion de gran
calidad facilmente exportable a formato RTF.

Enterprise Architect Corporate Edition soporta todos los modelos/diagramas de UML 2.0. Permite disefiar
desde procesos de negocio, sitios web, interfaces de usuario, configuraciones hardware, hasta estimar el
esfuerzo del proyecto en horas

Aunque el producto contempla dos tipos de repositorio (ficheros EAP o Base de datos) se ha optado por
el que mas posibilidades aporta, es decir, el basado en Base de Datos

Function EAP DBMS
Replication Yes NO
Number users 1..10 10..%
Non-Corruptible No Yes

El repositorio basado en DBMS proporciona mejores tiempos de respuesta cuando se trabajo con varios
usuarios debido a su estructura interna. Ademas, cualquier problema de conexién que se produzca, deberia ser
cubierto por las habilidades del servidor DBMS, permitiendo deshacer cualquier transaccion interrumpida por
problemas externos.

En nuestro caso se ha seleccionado SQL Server 7.0 como repositorio de proyectos, y la licencia
Corporate Edition.
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Enterprise Architect Corporate Edition implementa la tecnologia MDG (Model Driven Generator) que
permite centralizar una coleccién de recursos pertenecientes a una tecnologia especifica en un punto concreto
de Enterprise Architect Corporate Edition. Con MDG, el usuario tiene la posibilidad de realizar una importacién
granular de perfiles UML, patrones UML y plantillas en una Unica y accesible area contenida en la “Resource
View” de EA.

Para obtener informacion adicional sobre el producto acceder a su pagina web:

http://www.sparxsystems.com.au/products/ea.html

3 Funciones elementales

Aunque la herramienta permite gestionar dos tipos de repositorios (fichero EAP o Base de datos) se
recomienda el uso de la opcion de base de datos, ya que permite el trabajo concurrente a mayor nimero de
usuarios, evita la degradacion del proyecto y mejora los tiempos de respuesta del producto. No obstante el
responsable del proyecto podra seleccionar la opcién mas conveniente en cada caso.

Nota: El presente manual esta orientado principalmente al uso de DBMS como repositorio de modelos del
proyecto

Los pasos minimos que debe ejecutar el responsable del proyecto se pueden resumir como:

= Solicitar el repositorio del proyecto en BD

= Crear el proyecto

= Activar seguridad

= Establecer usuario(s) administrador(es)

= Crear grupos de usuarios y asignarles privilegios
= Crear usuarios y asignarlos a grupos

3.1 Crear el proyecto

Previamente (en fase 0) se habra solicitado al servicio de implantacién la creacion del repositorio en
SQLServer, facilitAndonos los siguientes datos:

= Nombre del servidor

= Nombre de la base de datos
=  Usuario

= Password

Importante: El proceso descrito a continuacion lo deberéa ejecutar el responsable del proyecto una sola
vez. Las sucesivas veces que se llevase a cabo supondria perder todos los modelos contenidos en el repositorio
remoto, es decir, seria equivalente a un proceso de reinicio del proyecto.

Que implantacion nos confirme la creacion del repositorio no significa que ya podemos empezar a

trabajar, tan solo disponemos del espacio necesario para gestionar el proyecto. Por tanto el primer paso a
realizar por el responsable es crear el proyecto, ejecutando el menu Tools-> Data Management->Data Transfer
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Full Model Data Transfer, rz

[rata Transfer Type
() EAP EAP (O DEMSto EAP  (5) EAPtoDEMS () DEMS to DEMS

Source and T arget kodels

Source Model: | | [ ]
Target Model: | | | |

Loafile

[ Logfile | |

Caution: All data will be erazed from the T arget Model prior bo data transfer. Flease ensure pou
have backed up target if neceszary

lransferData] [ Cloze ] [ Help ]

Frogress:

Completamos la pantalla:

= En el tipo de transferencia a realizar marcamos la opcién “.EAP to DBMS”

= En el campo de “Source Model” pinchamos el botén “...” que aparece alineado permitiéndonos

asi buscar en nuestro disco un fichero EAP que vamos a usar como modelo, bien porque lo
tenemos de otro proyecto similar anterior o bien si no disponemos de ninguno, podemos
seleccionar “ el que se instala por defecto con la herramienta EABase.eap”

= Pinchando el botoén “...” alineado con “Target Model” seleccionaremos como destino la BD SQL

Server que nos han generado:
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B3, Data Link Properties

Fravider Eu:unneu:tiu:unl .ﬁ.dvancedl All I

Select the data you want b connect to:

EJie

OLE DE Provider|z]

MediaCatalogDB OLE DB Provider
MediaCatalogtdergedDB OLE DB Prowvider
hediaCatalogw'ebDB OLE DB Provider

Microsoft Jet 4.0 OLE DE Provider

Microgoft OLE DB Provider For D ata Mining Services
Microzoft OLE DB Provider for DTS Packages
Microzaft OLE DB Prowvider for Indexing Service
Microzaft OLE DB Provider for Intermet Publizhing
Microzoft OLE DB Provider for Microzoft Search
Microzoft OLE DB Prowvider for ODEC Dirivers
Microzaft OLE DB Provider for Olap Services 3.0
Microsoft OLE DB Prowvider for Oracle
Microzoft OLE DB Provider for SOL Sepver
Microzoft OLE DB Simple Prowvider

k5D ataShape

F'rI-:weedDr de bazes de datoz OLE para zervicios de dire
4

MHest »»

ctar ™
3

Aceptar | Cancelar |

Apuda |

(@]

Una vez se ha seleccionado el driver de conexion a la base de datos (Microsoft OLE DB

Eusko Jaurlaritzaren Informatika Elkartea
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Provider for SQL Server) se debera indicar la conexién a la base de datos:
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B2, Data Link Properties X|

Provider Connection |.ﬁ.dvanced| All I

Specify the following to connect to SOL Server data:
1. Select or enter a zerver name:

|SEFWEFE v| Befresh |

2. Enter infarmation ta lag on ta the serer:
" Use Windows NT Integrated security

' se a specific user name and pazswond:

I zer name: IS?Sa_ea

HERKENE

Pazswoard: I
[T Blank pazsword [ Allow zaving paszword

3, [+ Select the database on the server:

|5738_E4| |

" Aftach a database file az a database name:

[ zinag the filerame;

| N

T est Connectian |

Aceptar I Cancelar Apuda |

Una vez de vuelta a la pantalla de transferencia de datos pinchamos en “Transfer Data” iniciando asi el
proceso de carga, aunque nos avisara de que todos los datos que contenga se perderan.

EA X

' Warning: ALL DATA in the target model will be deleted prior to uploading new data. Press OK ko conkinue, CAMCEL ko
e 4 abort

| ficepkar |[ Cancelar

Terminado el proceso pinchamos en “Close”.

Con esto ya tenemos realmente creado el proyecto.

3.2 Conexion al repositorio/proyecto

Una vez creado el proyecto nos conectaremos al servidor para ajustar la configuraciéon de seguridad y el
trabajo en grupo.
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Lo comentado a continuacion sirve como guia de conexion al repositorio remoto para cualquier tipo de
usuario.

ENTERPRISE
ARCHITECT v6.0 Search: .

Wy Profile...
Set Local Options...
Help with Enterprise Architect...

Manage Projects Recent Projects

* Open a Project File_..
* Create a Mew Project. ..
» Connect to Server__.

Pinchando sobre “Connect to Server...” se muestra la pantalla de seleccién de driver de conexién a BD
seleccionando Microsoft OLE DB Provider for SQL Server. Después indicaremos los pardmetros de conexion a
la base de datos. Ahora hay que darle como nombre el cédigo de aplicacion:

Connection Mame & Type

M arne:
#f3a |

[ratabaze Server

kS SOL Server...

ok l [ Cancel

Si la configuracién se ha efectuado de modo correcto, se cargara el proyecto EAP residente y existente
en la base de datos a la que se ha realizado la conexion, pudiéndose observar en la vista “Project View” los
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diferentes paquetes que componen el proyecto :

Diagramas Secuencia
Clases Implicadas

ITE'?IPrDject Wiew I@Resource View

En la pantalla principal se ofrece la posibilidad de abrir un proyecto ya existente, crear un nuevo proyecto
y/o conectarse a un servidor. Al haber seleccionado como repositorio de documentacion la opcion de base de
datos, el primer paso que debera realizar cualquier usuario (ademas del responsable de aplicacién) al iniciar la
aplicacién sera conectarse al repositorio a través de la opcién “Connect to Server”.

Si se ha activado la seguridad del proyecto y al usuario que intenta acceder se le ha dado de alta sin la
posibilidad de utilizar la seguridad Windows (no recomendado), le aparecera la pantalla de autenticacion:

& Login to EA Repository E|

| zerD:

Pazzword:

[ ] Remember U zerdD

[ Login l [ Cancel

Este punto se explicara mas adelante.

3.3 Modelo de seguridad

Enterprise Architect Corporate Edition permite aplicar seguridad de acceso al proyecto, ademas de
habilitar el acceso Unico a cada modelo con objeto de impedir modificaciones paralelas no deseadas.

Aunque en cualquier proyecto, y por defecto en su creacién, el modelo de seguridad que es aplicable a
partir del propio Enterprise Architect, esta deshabilitado, se recomienda mantenerlo activado. Asi, el responsable

de proyecto una vez generado (ver el apartado “Crear proyecto” del presente manual) debera ejecutar los pasos
indicados a continuacion.
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Importante: El proceso descrito a continuacion solo lo debera ejecutar el responsable del proyecto.

Para poder activar la seguridad se debera tener activo el propio proyecto. Si éste no dispone de politica
de seguridades aplicada, la activaremos accediendo al Project = Security=> Enable Security.

& PetStore - EA - Corporate Edition =13
: File Edt \iew | Project | Diagram Element Tools Add-Ins  Add-Ins  Settings  ‘Window Help

D)oo b | | ] Ak packace iy » Jwk- [OBABIE e - os2 -3 B
Tool ~ & X 5t Add Diagram. . Chrly »  Project View -3 x
al =] ——] &l Add Element Chrl+i B~ E- x| Byl d

Analysws| = @ Documentation » el I E B @ Vistas

Requerimientos Generales

£ Actor Source Code Engineering 3 [®] Casos de Usa

[ Object Build and Run 4 Casos de Test

2> Process Database Engineering 3 Diagrama Clases )

R Diagramas Secuencia

7 Callab, Architect...

O Send Madel Transformations ] Diagrama de Estada

en Clases Implicadas
=] Recsive il Modg] Validation b Recent Projects
. C| - Weh Services »
| = ¥ML Schema 3 aihf
Class .
Composite Security 3 o
Maintain Users...
Communic. .. Wersion Control 3
= Mainkain Groups...
Import/Export 3
Lisiacon partiEp Wiew and Manage Locks. ..
Timing Manage Baselines. .. Chri+alt+E IﬁEEIProject igw l@Resource View
. Change Password. .. -
State . Use Case Metrics... L - Instant Help & 53
— ogin as Another User ..,
Ackivity Wl View Project Statistics. ., . S —— _— @ IE @ ‘ a
Manage My Lacks,,, tH-Mayusculas+
Component C°”ceDt5ks
P S Basic Tas
Deployment [®_Enable securty... Quick Guids to EA
=t Require Iser Lock to Edit UML Madels
! Encrypk Password, ., Typical Roles

okl Code Engineering

Metamodel Database Modeling

WML Schema Dnc.umentatmn

Project Management

WWSDL MDG Technology

Requireme. . &% Model Management:

Mainkenance

User Inker...

EPMMN Core

EPMM Types || q Start Page J I ENDtES ID%Properties l@lnstant Help
5 - q 5+ —
i@ AN - TTE 52| pefou syl - p-likvRTrikunnlenaaaeaqlkas XA
Enable security in model CAP MUM SCRL

Se solicita un cédigo de autorizacién que debemos completar.

Enter authorization [$_<|

Enter authorization key:

k. l [ Cancel ] [ Help

Nota: Esta clave se facilita cuando se hace la compra del producto.

Una vez introducida nos avisa de que ademas se ha generado un usuario administrador por defecto:
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EA B3

Security has been enabled on the current model. You can now login as 'admin' with the password ‘password' and
. create and administer users, graups and permissions’

Acepkar

Una vez activada la seguridad se recomienda marcar la opcién “Require User Lock to Edit”, lo que
garantizara que no habra modificaciones indeseables por modificaciones concurrentes de mas de un usuario al
mismo objeto. Con esta opcion el usuario antes de poder realizar cualquier modificacién deberéa bloquear el
objeto, asegurando entonces su uso exclusivo. Asi, una vez finalizado el cambio debera desbloquearlo.

Enterprise Architect pide confirmacion antes de efectuar esta operacion.

& ‘fou are about o change the locking mode so that elements can ORLY BE EDITED if you LOCE them,

This represents a complete inversion of the current behaviar, and wou should anly proceed iF you are certain af the
CONSEqUEnces,

Do wou wish to proceed?

Enterprise Architect también admite otros modelos de bloqueo menos restrictivos, por lo que sera
decision del responsable de aplicacion adoptar la mejor opcién para cada caso.

Una vez se ha accedido al proyecto con las credenciales autorizadas se podran realizar sobre el proyecto
seleccionado las operaciones asociadas a los diferentes perfiles que se hayan creado para el proyecto, y en
funcion del usuario autenticado podra efectuar aquellas operaciones que le estén permitidas.

Una vez ha sido habilitada la seguridad, se puede acceder a las otras opciones de administracion.
3.4 Trabajo en grupo

El repositorio basado en DBMS proporciona mejores tiempos de respuesta cuando se trabajo con varios
usuarios debido a su estructura interna. Ademas, cualquier problema de conexién que se produzca, deberia ser
cubierto por las habilidades del servidor DBMS, permitiendo deshacer cualquier transaccion interrumpida por
problemas externos.

Los repositorios DBMS no ofrecen los servicios de replicacion que ofrecen los repositorios EAP. Esta
funcionalidad es cubierta por el Control de Paquetes y el Control de Versiones.

Cuando se utiliza DBMS como repositorio, la exportacion/importacién XMl se puede utilizar para modelar
distintos paquetes, exportar a XML y compartirlos entre los miembros del equipo de desarrollo, o incluso como

escenario de intercambio con las empresas colaboradoras. La utilizacion de DMBS tiene amplias ventajas con
respecto a la replicacion:

1. Se puede crear un modelo con solo las partes necesarias para la realizaciéon de un determinado
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Se puede crear el modelo completo en caso de ser necesario

Se puede crear un modelo desde diferentes versiones de paquetes con distintos propésitos (vista

cliente, version definitiva interna)

4. Menor probabilidad de colisiones entre desarrolladores si cada uno trabaja en distintos paquetes.

El proceso es controlable utilizando el sistema de control de versiones

El responsable de la aplicacién ser4 el encargado de realizar los mantenimiento de usuarios y grupos

para el proyecto

3.4.1. Mantenimiento de usuarios

Importante: El proceso descrito a continuacion solo lo deberé ejecutar el responsable del proyecto.

Para gestionar los usuarios y la asignacion de estos a los posibles grupos y permisos identificados para el
proyecto acceder al menu Project-> Security->Maintain Users:

System Users

— Uzer Details
Logir: ||
Firstrarme: I
SLIMMArE; I
Department; I
Change Fazsward |

— Set Permizsions

[Eroup fMembership |

Single Permissions |

viewsl |

[T Accept windows Authentication

|dzers: Mew | Save I Delete |
Surname | Firsthame | Login ]
Adrinistrator The adrnin

petstore petstare petstore

Help |

Cloze |

Para efectuar un alta de un usuario en el sistema, se pulsara el botén de “New”, el cual permite acceder al

apartado de User Details con todos los campos en blanco para proceder a su definicion:
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— Uzer Detailz

Logir: I
Firsthame: I
Sumame: I
[repartment: I

Change Fassword |

[ Accept Windows Suthentication

Se recomienda utilizar el sistema de credenciales compatible con las propias de acceso al sistema
Windows, para ello bastara tan solo el activar la casilla “Accept Windows Authentication”. Una vez introducida la
informacion, procederemos a almacenar la misma pulsando el botén”Save” apareciendo entonces en la lista
“Users”.

Para efectuar una actualizacion de los datos asociados a un usuario en el sistema, se procedera a
seleccionar previamente al usuario de la lista, se cumplimentara la informacién del usuario a modificar existente
en el apartado de “User Details” con todos los campos con la informacion original ya cumplimentada y pulsar
“Save”.

Para efectuar un borrado de un usuario del sistema, se procedera a seleccionar previamente al usuario
de la lista, se pulsara sobre el botén “Delete”, el cual procedera a realizar el borrado del sistema. Es muy
resaltar que el borrado es fisico y que el sistema no pide confirmacién del mismo, por lo que se debera estar
muy seguro de la operacion a efectuar, ya que la misma no es reversible.

Si lo que se desea es asignar o quitar privilegios al usuario, se procedera a seleccionar previamente al
usuario de la lista, y en funcion a los privilegios que se deseen asignar o quitar al usuario, se seleccionara una
de las tres opciones posibles:

— Set Permizsions

Group Membership |

Single Permiszions |

Viewdll |

La opcion “Group Membership”, permite la asignacion/desasignacion de un usuario a un grupo. Una vez
pulsada esta opcion, mediante botones de opcién, los que estén marcados generaran la pertenencia a los
grupos marcados y los que no estén marcados el usuario no dispondra de pertenencia a ellos:
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— User Details
Login; IpetsT
Firstname: Ipelstore—
Surname: ||:|et$tc|n3—
Department: Ipnetstone—
Change Pagsword |

Group Membership |
Single Permizsions |
Wi Al |

—Set Pemizsions————

Eusko Jaurlaritzaren Informatika Elkartea
Sociedad Informatica del Gobierno Vasco

EJie

P

il S5

ECUENCia
Cok-dm

User Groups

Tick Required Groups:

[ lAdministrators

[ Accept windows Authentication

sers: Hew | Sawe | Delete
Surname | Firstname | Login |
Adriniztrator The admin

petztore petstore petstore

Help |

Cloze |

Cancel Help

o]

La opcion “Single Permissions”, permite la asignacion/desasignacion de un usuario a los diferentes
permisos existentes en el sistema. Una vez pulsada esta opcion, mediante botones de opcién, los que estén
marcados generaran la pertenencia a los permisos y los que no estén marcados el usuario no dispondra de
pertenencia a ellos. Se recomienda asignar permisos a través de la pertenencia a un grupo al cual se le asignen

los permisos deseados:

System Users

TR rp—
; Diagrama Clases
Diagramas Secusncia

v Accept \Windows Authentication

Configure Packages
[1Caonfigure Resources

Help |

Users: MHew | Save | Delete | [ ]Configure Sterectypes
[1Configure Yersion Contral
Surname | Firstname | Login | W Export Ml
Admiriztrator The admin [ 1Generate Documents
petstore petstore petstore [W]Generate Source Code and DDL

¥ mpo

- User Detail - Set Permissions Diagrama de Estado
Login: petstore — —
& Groun Mambershi User Permissions 5'
Firstnarme: petstore —lp 2
5 petstore Tick required permizzions
Urhianme: Single Permizsi —
M [ lAdminister Databaze - kK I
Department: IDBtStOfE : Change Pazsword
Wiew Al | [ 1Check Data Integrity Cancel |
Ehange Password | [ Configure D atatypes
[ 1Configure Images

Help |

Close |

&$ Code Engineering
&P Database Modeling
2 Documentation
Project Managerment

La Opcién de “View All” es una combinacién de las dos anteriores, por lo que se veran todas las opciones
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EJie

juntas y mezcladas en la misma pantalla de asignacién, desasignacion.

— Uzer Details
Lagin: petstore
Firstname: petstore
Surname: petstore

Department: IPBtSlDfB
Change Pazsword |

— Set Pemissions

Group Membership |
Single Permizsions |
Wiew &l |

Ird Accept Windows Authentication

Help |

Uzers: Mew | Save | Delete |
Surname | Firsthame | Laogin |
Administrator The admin

petstore petstaore petstore

Close |

[EE T PR

Diagrama Clases

Diagramas Secuencia

¥ [#3] Diagrama de Estado

All user permissions x|

Aszigned permissions:

[ Administer Databasze -
[1Change Password

[C1Check Data Integrity

["Configure D atatypes

[ 1Configure Images

[ 1Configure Packages

[ 1Configure Resources

[ 1Configure Stereotypes

[ 1Configure Wersion Control

[1E =port 3<hI

[ 1Generate Documents

[ 1Generate Source Code and DDL

[ lmport k4l

[ILock Elements ﬂ

3.4.2. Usuario administrador

Importante: El proceso descrito a continuacion solo lo deberé ejecutar el responsable del proyecto.

L
&% Code Engineering
Database Modeling

7 Documentation
&% Project Managemenk

Para evitar accesos no permitidos con perfil de administrador es basico actualizar los datos del usuario

administrador creado por defecto.

Acceder al menu Project-> Security->Maintain Users, y seleccionar de la lista “Users:” el referenciado
como “Administrador”. Poner como login el cédigo de usuario utilizado para entrar al dominio Windows de
EJGVNET y marcar “Accept Windows Authentication”, con lo que no pedira usuario/password si ya estamos

autenticados en el dominio.

Es recomendable generar otro usuario con permisos de Administrador (perteneciente al grupo

“‘Administrators”).

3.4.3. Mantenimiento de grupos

Importante: El proceso descrito a continuacion solo lo debera ejecutar el responsable del proyecto.

Para gestionar los grupos y los permisos o privilegios identificados para el proyecto acceder al menu

Project-> Security->Maintain Groups:
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Security Groups x|
Garoup Mame I
Dezcrption I
Set Eroup Permizsions: |
Groups: 24ve | Delste |
Group Hame | D ezcription |
Adminiztrators System Administrators
Cloze Help

EJie

Eusko Jaurlaritzaren Informatika Elkartea
Sociedad Informatica del Gobierno Vasco

Para efectuar un alta de un grupo en el sistema, se procedera a pulsar el boton de “New”, el cual permite
el acceder a la parte superior de la pantalla, con los campos de Nombre de Grupo y Descripcion de Grupo en

blanco para proceder a su rellenado:

Security Groups El
Group Mame I
Dezcription I
Set Group Permizsions |
Groups: Save | Delete |

Una vez introducida la informacion, se procedera a almacenar la misma pulsando el boton “Save”, el cual
se habilita en el momento de haber cumplimentado toda la informacién asociada al grupo.
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Security Groups x|
Garoup Mame IpetstnreGrDup
Dezcription IpetstnreGrDup
Set Eroup Permizsions: |
Groups: Mew | Save | [elete |
Group Hame | D ezcription |
Adminiztrators System Administrators
Cloze Help

Para efectuar una actualizacion de los datos de un grupo en el sistema, se procedera a seleccionar
previamente al grupo de la lista, se cumplimentara la informacion asociada al grupo con todos los campos con la
informacioén original ya cumplimentada.

1
| Security Groups

Group Mame IpetstnreGrnup

+ Deszcription IpetstnreGrnup dezcription

St Group Pemmizsions |

Una vez introducida la informacion, procederemos a almacenar la misma pulsando el botén de “Save”, el
cual se habilita en el momento de haber cumplimentado toda la informacién asociada al grupo.

Para efectuar un borrado de un grupo del sistema, procederemos a seleccionar previamente al grupo de
la lista, se pulsara sobre el botén “Delete”, el cual procedera a realizar el borrado del grupo del sistema y elimina
automéaticamente las asignaciones de usuarios pertenecientes a ese grupo. Es muy importante sefialar que el
borrado es fisico y que el sistema no pide confirmacion del mismo, por lo que se debera estar muy seguro de la
operacion a efectuar, ya que la misma no es reversible.
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Security Groups x|

Garoup Mame IpetstnreGrDup

Dezcription IpetstnreErDup Drescription

Set Group Permizszions |

Groups: Hew | Save I Delete |

Group Hame | D ezcription |
Administrators System Administrators

etztorelGroup etztorelaroup

Cloze Help

Si lo que se desea es asignar o quitar privilegios al grupo, se procedera a seleccionar previamente al
grupo de la lista, y en funcién a los privilegios que se deseen asignar o quitar al usuario, se seleccionaran o no
los privilegios a asignar al grupo marcando o desmarcando las casillas de opcién habilitadas para tal fin:

Security Groups Group Permissions ﬂ
Group Mame IpetstoreGmup Tick required permissions
- — Adminizter D atab
[ezcription Ipetstoreﬁmup Dezcription gth::;:z n;rassawamjse =
Set Group Permizsions | [|Check Data Integrity
[ |Configure D atatypes

[ |Caonfigure Images
et | e | Delete | [ |Configure Packages

B [ |Configure Resources
Group Mame | Dezcriphion | [ |Configure Stereotypes
Adrmiristrators Systern Administratars []Configure Yersion Contral
petztorelroup petetoreGroup Dezcription [ |Ewpart x4l

[|Generate Documents
[ |Generate Source Code and DDL
[ raport =k _I

1l Al Flamanks

Cancel Help |

Cloze Help

Pare el conjunto de usuarios que van a colaborar en la creacion de los modelos se recomienda crear un
grupo con los siguientes permisos:
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EJie

Permission

Meaning

Change Password

Change password of current user.

Configure Datatypes

Add/Modify and Delete Datatypes.

Configure Images

Configure alternate element images.

Configure Packages

Configure controlled packages and package properties.

Configure Resources

Import and manage resources tab items: patterns, profiles, favorites etc.

Configure Stereotypes

Add/Modify and Delete Stereotypes.

Generate Documents

Generate RTF and HTML documents from model packages.

Generate Source Code and DDL

Generate source code and DDL from model element. Synchronize if already
exists.

Lock Objects

Lock an element.

Manage Diagrams

Create new diagrams, copy existing and delete diagrams. Also save diagram as
UML Pattern.

Manage Issues

Update and delete Issues.

Manage Project Information

Update and manage resources, metrics, risks etc.

Manage Reference Data - Update

Update and delete reference items.

Manage Tests

Update and delete Test records.

Reverse Engineer from DDL and Source
Code

Reverse engineer from source code or ODBC. Synchronize with model
elements.

Security - Manage Locks

View and delete element locks.

Spell Check

Spell check package and set spell check language.

Update Diagrams

Update diagram properties and layout, including the Page Setup dialog.

Update Elements

Save changes (including delete) for elements, diagrams, packages, links, etc.

View Locks

View element locks.

3.4.4. Gestion de blogueos

Si se ha activado la opcion “Require User Lock to Edit” (recomendado) cuando un usuario bloquea un
objeto, debera liberarlo explicitamente cuando finalice su tarea de modificacién. Esto evidentemente puede
generar problemas, bien por olvido, bien porque sea necesario adquirir el objeto en un momento dado y el
usuario que lo tiene bloqueado no esta disponible, etc.

Es importante recordar que para poder bloquear un elemento el usuario debe tener perfil de administrador

o tener asignado el privilegio “Lock Objects “.

Para consultar y gestionar los diferentes bloqueos activos para el proyecto acceder al menu
Project-> Security—>View and Manage Locks:

20/26



= Eusko Jaurlaritzaren Informatika Elkartea
le Sociedad Informéatica del Gobierno Vasco

Active Locks x|
Wiew Locks For:
|V a4 " Groups Only = Users Only
Active Locks: Select All I Select Mone
Type Mame |Jzer | Group | Timnestamp &
Diagram Cazoz de...  admin Administrat..  19/07 /2006
Diagram Requermi...  admin 19407 42006

Diagram Requerimi...
Diagram R equeririi...
Diagram SD-Bean ...
Diagram

adrmin

adrin
admir

Adrniniztrat. .

Diagram . 19/07 /2006 —
Diagram ACU_PetS...  admin Adrarastrat... 19407 /2006
Element tilizacion ... admin 19407 42006
E lement Gestion Ex..  admin 19407 42006
Element Requermi...  admin 19,07 /2006
Comprar ... admin 19/07 /2006
Element Eliminar &n...  admin 19407 42006
E lement Agregar & admin 19407 42006
Element Conzultar...  admin 19,07 /2008
Element Maodficar ... admin 19407 42006
Element Congultar ... admik 1907420068 -
1| [»

19/07 /2008

18/07 /2006
13/07 /2006

159407 /2006

nlock Selected

Cloze

| Help |

Es importante recordar que esta opcion solo estara activa para usuarios administradores y para aquellos
a los que se les asigna el privilegio “Security - Manage Locks”.

Para desbloquear objetos, se puede seleccionar uno por uno de la lista, o pulsando “Select All” se
marcaran todos, pinchando después “Unlock Selected” se desbloqueran todos los seleccionados

Si ha activado la seguridad y la opcién “Require User Lock to Edit”, para bloguear un elemento, hay que
posicionarse en la pestafia “Project View” sobre el objeto que se quiere editar, y pulsando botén derecho
ejecutar la opcion “Apply/Release User Lock...”

Set User Lock

Actian

() Releaze User Lock

Include Child Packages

)

Esta opcién de menud también permite el desbloqueo si nos posicionamos sobre algun objeto bloqueado
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previamente.

3.4.5. Otras funciones

Cambio de password

Opcién que permite la gestion de la contrasefia del usuario activo. Desde este apartado se permite
cambiar la contrasefa para el usuario que esta identificado en el proyecto en ese preciso instante. Para
ejecutarlo se debe acceder al menud Project->Security=>Change Password

Change Password X

Enter ald paszward: || | 0k, I
Mew pazsword: I Cancel |

Retype new: I

Login como otro usuario

Desde este apartado se permite cambiar el usuario identificado o autenticado en el proyecto. Para
ejecutarlo se debe acceder al menu Project->Security>Login As Another User.

%¥ Login to EA Repository El

el D Iadmin

Pazzwaord: ||
v Femember UzerlD

Login I Cancel

Se permite un maximo de tres reintentos en la introduccién de un usuario y contrasefia validos para
acceder al proyecto. Si por un casual se intentara por mas de tres ocasiones consecutivas y estas fuesen
incorrectas o erréneas, el Enterprise Architect mostrara un mensaje de error, y realizard una salida del acceso al
proyecto seleccionado.

4  Integracion con la tecnologia MDG

4.1 Trabajando con tecnologias MDG

Las tecnologias MDG se aplican por cada proyecto, no son configuraciones generales de la herramienta
Enterprise Architect.

Para obtener informacion adicional, acceder a la pagina:
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http://www.sparxsystems.com.au/resources/mdg_tech/

4.1.1. Importar tecnologia MDG como fichero XML

En la ventana de “vista de recursos” del proyecto, y estando situados encima de la carpeta “MDG
Technologies”, con el botdén derecho seleccionar “Import Technology”.

= ﬁ Resources
B& Y10 Technobogi: _
= Enterprise :|E| Impart Ted'lnnlogi[i
B EUMLPrd  Hep X
@ UI"‘"I_ Fromme T o
UML Patterns
Code Management

Import Technology E|

Technalogy: |EnterpriseJava Beans | Yersion: | 1.0 Beta

Filenarne: |E:"-.-'-‘-.r|:hiw:|s de programaSpars Systemsih00G Link\EJBAEJE | | |

Irmpart B esources

Patterns

Frofiles Code Modules
Frafile Features Code Module Features
Element Size

Alternate Image Code Templates

Color and Appearance

Wiew ][ Impaort ][ Cancel ] [ Help

Y pulsar “Import”

4.1.2. Uso delatecnologia MDG

El posible uso de la tecnologia MDG importada en el proyecto dependera de las posibilidades a las que
esta destinado, y podran aplicarse a perfiles de elementos, patrones, plantillas de cddigo, modelos de datos, etc.
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E=| q: Resources
= q’ MDG Technologies
EI ﬁ Enterprise Java Beans
=1 [5] UML Profiles
= [ UML Profile for EJ8
¢ EJBCreateMethod
¢ EJBFinderMethod
¢ EJBRemoteMethod
- = EIJBENtityHomeInterface
- w=(3 EJBRemotelnterface
- o= EJBSessionHomelnterface
-~ EJBPrimaryKey
- gp EJBCmpField
- g EJBPrimarykeyField
=" EJBRealizeHome
EJBReslizeRemote
EJBImplementation
EJBSeszsionBean
EJBEntityBean
EJB-JAR.
EJBDescriptaor
EJBClient]AR
- EJBAcCcess
- = EJBReference
[ (2] UML Patterns
- Code Management
- (5] UML Profiles
- (28] UML Patterns
[+ Templates
[+ @ Documents
ﬂ Matrix Profiles
Favorites
Styleshests

EIF'rDject View | @F‘.esnurce View

4.2 MDG Business Process

BPMN define diagramas de procesos de negocio, basados en la construccién de modelos gréaficos de
operaciones de procesos de negocio mediante la creacion de organigramas. Esta notacion es facilmente
entendible por todos los usuarios, desde los analistas que crean los primeros disefios de los procesos, hasta los
programadores responsables de la codificacién de dichos procesos, y finalmente, por los encargados de
gestionar y monitorizar dichos procesos.
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Waking Froup
Still Active™

Ched Status of
Warking Group

Send Current Issue List

Wiarking
Group
Putive

Friday atGpm
P acific Time

BPMN MDG proporciona soporte BMPN a Enterprise Architect

Proporciona a Enterprise Architect un completo entorno de implementacion de procesos de negocio.
Permite expresar dichos procesos a través de una notacion grafica estandar.

Compartir modelos

Los modelos de negocio y de software pueden ser combinados con BPMN, creando una Unica aplicacion
para todos los modelos. Esto mejora la comunicacién y la productividad a lo largo del disefio.

Validacién de los modelos BPMN

Los diagramas de procesos de negocio pueden ser validados a través de una serie de reglas y
restricciones.

Prepare and Send
@ Candidate ltineries

Travel Order [=d|

Receive Confirmation

Send Cancellation
Maotice

Nota: Este producto tiene un coste adicional en su version basica, no teniendo coste adicional en

producto licenciado como empresarial o corporativo. Requiere un proceso de instalacion adicional y posterior a
la propia instalacion de la herramienta Enterprise Architect.

4.3 MDG for Eclipse

Proporciona una serie de caracteristicas a Eclipse que permite aumentar la productividad.

Con el link MDG para Eclipse, la navegacion entre Enterprise Architect y Eclipse es directa, mediante una

simple combinacion de teclas, se puede acceder directamente desde un modelo de Enterprise Architect a la
localizacion especifica del codigo en Eclipse.

Este link proporciona una interfaz flexible para el control de la importacion y exportacion de codigo,
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ingenieria directa e inversa de todo un proyecto puede ser realiza en un solo proceso. El usuario tiene la opcion
de seleccionar que clases son incluidas en la importacion y exportacion, asi como la localizacion de los ficheros
de dichas clases. Incluso se puede compilar y ejecutar un proyecto desde Enterprise Architect.

Nota: Este producto tiene un coste adicional, por lo que actualmente no se ha considerado su compra.
4.4 MDG for Eclipse

El link MDG para Visual Studio .NET proporciona una solucioén para los usuarios de la versiones
profesional y corporativa de Enterprise Architect y Visual Studio .NET. Proporciona una serie de caracteristicas a
Eclipse que permite aumentar la productividad.

Con el link MDG para Visual Studio .NET, la navegacién entre EA y Visual Studio .NET es directa,
mediante una simple combinacién de teclas, se puede acceder directamente desde un modelo de Enterprise
Architect a la localizacion especifica del cédigo en Visual Studio .NET.

Este link proporciona una interfaz flexible para el control de la importacion y exportacion de codigo,
ingenieria directa e inversa de todo un proyecto puede ser realiza en un solo proceso. El usuario tiene la opcién
de seleccionar que clases son incluidas en la importacion y exportacion, asi como la localizacion de los ficheros
de dichas clases. Incluso se puede compilar y ejecutar un proyecto desde Enterprise Architect.

Nota: Este producto tiene un coste adicional, por lo que actualmente no se ha considerado su compra.
45 MDG for EJB

Permite al usuario modelar EJBs de entidad y de sesion, se completa con perfiles UML para modelar
Ejes, patrones de EJB y gestion de cddigo

Nota: Este producto no tiene coste adicional. Se instala por defecto junto con la herramienta Enterprise
Architect.

El fichero de importacion “EJB Technology.xml” se instala en “C:\Archivos de programa\Sparx
Systems\MDG Link\EJB”

46 MDG for Testing

Proporciona la usuario la capacidad de modelar rapidamente un amplio rango de procedimientos de test
incluyendo componentes de testeo, casos de test, y mas

Nota: Este producto no tiene coste adicional. Se instala por defecto junto con la herramienta Enterprise
Architect.

El fichero de importacion “Testing Technology.xml” se instala en “C:\Archivos de programa\Sparx
Systems\MDG Link\Testing”
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